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Introduction

The purpose of this guidance is to follow Executive Order 12898 and FHWA Order 6640.23A to ensure
Minority and Low-Income populations are not disproportionately impacted by ODOT projects. Per FHWA
Order 6640.23A, a disproportionately high and adverse effect on a minority or low-income population
means the adverse effect is predominately borne by such population or is appreciably more severe or
greater in magnitude on the minority or low-income population than the adverse effect suffered by the
non-minority or non-low-income population (FHWA, Information: Guidance on Environmental Justice and
NEPA, 12/16/11).

ODOT’s Environmental Justice process has been revised to provide more defined guidance to ODOT
District Environmental Staff and consultants. This guidance must be followed for all C2, D1, D2, and D3
level CEs as well as EA and EIS documents.

Step 1:

ODOT District Environmental Staff and consultants will need to use the USEPA’s EJ View tool to identify
Environmental Justice Populations within your proposed project or study area. To do this, please first go
to the link below:

http://epamapl4.epa.gov/ejmap/entry.html

ODOT’s Guidance to Identify Environmental Justice Populations

Follow the steps below to obtain US Census Data from this website for your project. You will want to
obtain block group data for your specific project or study area.

Please note that the 2010 data in the USEPA’s EJ View tool does not include block group data for “Below
Poverty” populations. Therefore, you will need to obtain 2000 block group data for “Below Poverty”
populations and 2010 block group data for “Minority” populations.

1.) Inthe “Go to EJ View” search box, please type in the municipality and State in which your project
is located. Ifitis not located within a municipality, please type in the nearest municipality to your
project area. You will then need to “pan” over, up, or down to locate your project area.

2.) Second, you will need to turn on the minority and low income layers of data. You will want to
turn on one layer at a time. This can be done by expanding the “Demographics” folders from the
“Select Map Contents” box on the right side of the screen. To do this, please click on the + next to
the word “Demographics 2000” and “Demographics (SF1) 2010”. Once you have expanded the
“Demographics 2000” and “Demographics (SF1) 2010” folders, begin by selecting the + next to
“Below Poverty” (in the “Demographics 2000” folder). Please note that EJ View uses the term
“Below Poverty” instead of “Low Income”. You will want to obtain block group data so check the
box next to “Block Group Data”. You may need to zoom in or out to be able to select the block
group data box. Once you have this box checked, color-coded block group data should appear on
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your screen. Please note that you may have several block groups for your particular project area.
This data search will include all block groups within the project area.

3.) Next, you will want to print this map. To do this, select “Print Screen” from your keyboard. Select
the “Copy” icon from top of the page. Open Microsoft Word and paste this image into the Word
document. You will then need to draw a box around your project area. First, select the “Insert”
tab from the top of the Word document. From this tab, select Shapes, Lines, and select the second
icon from the right labeled “freeform”. This will allow you to draw a shape around your project
or study area. Once you have drawn your shape, you will need to use your mouse to click on your
shape and then select the “Format” tab. Select the “Shape Fill” and then select “No Fill”. You can
also change the color of the shape if you choose.

4.) Follow these same steps to turn on the “Minority” data layer as well in the “Demographics (SF1)
2010” folder and to copy this map. You will need to save these maps and upload them to your
environmental document’s project file.

The block group percentages from the map legend are used to determine whether or not you have a block
group of 40% or higher within your proposed project area. If all of the block groups within your proposed
project area indicate Environmental Justice populations below 40%, then no additional Environmental
Justice analysis or coordination is required. Instead of the exact percentages and block group numbers
from the EJ View, please include either greater than 40% or less than 40% in the table provided on the
Environmental Justice tab of the CE Online form and include the word “Various” under block group ID.
Please note that you will need to write out the words “greater than” and “less than”. The CE Online
system does not recognize symbols (> and <). You will also need to upload the mapping to the CE Online
project file associated with your proposed project and enter the following write-up in the Environmental
Justice tab remarks box of the online document:

The proposed project will have no disproportionately high and adverse impacts to minority or low-income
populations based upon the table above and the attached mapping. No Environmental Justice issues were
raised as a result of public involvement activities conducted as part of the proposed project. Therefore, in
accordance with the protections of Executive Order 12898 and FHWA Order 6640.23A, no further
Environmental Justice analysis is required.

If any of the census data block groups indicate a percentage of 40% or greater within your proposed
project or study area, please go to Step 2.

Step 2:

After completing the table and the mapping, if the minority and/or low-income data indicate a population
of 40% or greater within your proposed project area, you will need to answer the questions provided in
the Environmental Justice tab of the CE Online form (see below). The answers to these questions will
indicate whether or not an Environmental Justice Analysis Report is required.

Environmental Justice Questions in CE Online Form

1. Arethere any relocations? If Yes, then:
1.a. Are there residential relocation(s)? If yes, then:
- 1.a.1 Was a Relocation Assistance Program (RAP) report performed? If No, then an
Environmental Justice Analysis Report is required. If Yes, then:
- 1.a.2. Did the RAP report recommend Housing of Last Resort?



1b. Are there business relocations? If Yes, then:
- 1.b.1 Will any minority owned businesses be relocated as part of the proposed
project?
- 1.b.2 Will any businesses primarily serving an Environmental Justice population be
relocated as part of the proposed project?
- 1.b.3 Will this project result in substantial job loss for an Environmental Justice
population?

If you answer No to question 1.a.1, then an Environmental Justice Analysis Report must be completed. If
you answer Yes to questions 1.a.2, 1.b.1, 1.b.2, or 1.b.3, then an Environmental Justice Analysis Report
must be completed.

2. Will there be any changes to access? If Yes, then:
2a. Will access to shopping, bus stops, schools, jobs, recreational resources, community centers,
etc. be substantially impaired for an Environmental Justice population?
2b. Will man-made dividers such as an overpass, bridge, 4-lane or greater roadway or railroad
negatively impact community cohesiveness for an Environmental Justice population?
2c. Will access to or use of the transportation improvement be denied to any low income or
minority population or groups (for reasons such as cost to use, ability to access, etc.)?

If you answer Yes to question 2, but No to question 2a, 2b, and 2c, please explain in the remarks box the
changes to access and how these changes will not have a substantial negative impact to Environmental
Justice populations. If these changes will have a substantial negative impact to Environmental Justice
populations, please contact OES to determine if an Environmental Justice Analysis Report is required. If
you answer Yes to questions 2a, 2b, or 2c above, then an Environmental Justice Analysis Report must be
completed.

3. Were any Environmental Justice issues that could result in a disproportionately high and adverse
effect raised during Public Involvement? If Yes, then:

Consult with ODOT’s OES to determine whether an Environmental Justice Analysis Report is necessary. If
you are consulting this guidance before any Public Involvement is completed, you will need to answer this
guestion once Public Involvement has been completed.

4. Are there any other unique factors of the proposed project that could pose a disproportionately
high and adverse impact on an Environmental Justice population? Please answer the questions
below.

4a. Will the proposed project negatively impact pedestrian, bicyclist and/or motorist safety?

4b. Will the project result in negative environmental impacts such as noise, air, water, vibration,
community character, etc.?

4c. Will the proposed project result in secondary or cumulative negative impacts?

If you answer Yes to questions 4a, 4b, or 4c above, then an Environmental Justice Analysis Report must
be completed.



After answering these questions, if an Environmental Justice Analysis Report is not required, add the
following in the remarks box of the CE document:

The proposed project will have no disproportionately high and adverse impacts to minority or low-income
populations based upon the table above, the attached mapping, and the answers to the questions above.
No Environmental Justice issues were raised as a result of public involvement activities conducted as part
of the proposed project. Therefore, in accordance with the protections of Executive Order 12898 and FHWA
Order 6640.23A, no further Environmental Justice analysis is required.

If an Environmental Justice Analysis Report is required, then please go to Step 3.

Step 3:

Please contact ODOT-OES’ Policy Section if an Environmental Justice Analysis Report is required for your
project. This report is prepared to determine whether or not your project will have a disproportionately
high and adverse impact to an Environmental Justice population and to document any avoidance and
mitigation measures. The Policy Section will work with you to complete this report. Once completed, all
Environmental Justice Analysis Reports must be submitted to ODOT-OES and FHWA for review and
concurrence. Please note that ODOT-OES and FHWA will not concurrently review these reports. ODOT-
OES will review and provide comments. Once OES’ comments have been addressed, the report will be
sent to FHWA to review. ODOT OES and FHWA will issue a concurrence e-mail for these reports.

An outline of the Environmental Justice Analysis Report is below. The sub-bullets include information that
must be discussed under each heading, if applicable.

Outline for Environmental Justice Analysis Reports

=

Project Description
a. Thisis the same project description that is included in the CE document.

2. A summary of the Purpose and Need Statement

a. This is the same Purpose and Need Statement that is included in the CE document.
Please note you do not need to include the entire Purpose and Need Statement in the
Environmental Justice Analysis Report, only a summary.

w

Discussion of data for Environmental Justice population(s) within the proposed project area
4. Discussion of Impacts to Environmental Justice population(s)
a. Amount of temporary and/or permanent right-of-way to be acquired
Number of residential relocations
Did the RAP recommend Housing of Last Resort?
Number of business relocations
If there are business relocations, are any minority owned businesses?
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If there are business relocations, do any primarily serve Environmental Justice
populations?

g. Will this project result in substantial job loss for an Environmental Justice population?
h. Changes to access

i. Changes to multi-modal transportation



j. Environmental impacts (noise, air, vibration, water quality, etc) to Environmental
Justice populations
k. Will the project result in secondary or cumulative impacts?
5. Public Involvement Summary
a. Describe the Public Involvement process for your project and how Environmental
Justice populations were included in this process
b. State whether or not Environmental Justice issues were raised during the Public
Involvement process
c. If Environmental Justice issues were raised during Public Involvement, discuss these
comments and the responses provided
Include Environmental Justice related comments and responses in Appendix
e. Please note that you do not need to discuss all Public Involvement comments in this
section nor include all Public Involvement comments in the appendix. Instead, please
briefly discuss the Public Involvement for the overall project and reference the Public
Involvement section of the CE document.
6. Discussion of Avoidance and , Minimization or Mitigation Measures
a. Describe other alternatives and whether or not the impacts were different for each
alternative (to show avoidance)
b. Describe any mitigation or enhancement measures and include as environmental
commitments
7. Summary
a. The summary should recap the report and include a final determination for whether
or not the project will have a disproportionately high and adverse impact to the
Environmental Justice population. The summary should include justification for the
determination.

For Item #3 in the above outline, you will need to follow the following steps to obtain the exact
percentages for each block group within your project or study area:

1. Inthe “Go to EJ View” search box, please type in the municipality and State in which your project is
located. If it is not located within a municipality, please type in the nearest municipality to your
project area. You will then need to “pan” over, up, or down to locate your project area.

2. Second, you will need to turn on the minority and low income layers of data. This can be done by
expanding the “Demographics” folders from the “Select Map Contents” box on the right side of the
screen. To do this, please click on the + next to the word “Demographics 2000” and “Demographics
(SF1) 2010”. You will want to turn on both layers at the same time. Once you have expanded the
“Demographics 2000” and “Demographics (SF1) 2010” folders, begin by selecting the + next to “Below
Poverty” (in the “Demographics 2000” folder). Please note that EJ View uses the term “Below
Poverty” instead of “Low Income”. You will want to obtain block group data so check the box next to
“Block Group Data”. You may need to zoom in or out to be able to select the block group data box.
Once you have this box checked, color-coded block group data should appear on your screen. Follow
these same steps to turn on the “Minority” layer as well in the “Demographics (SF1) 2010” folder. It
may take a few minutes to load both of these layers and for them to appear. Please note that the
screen will not show both color coded data at once. As long as the box next to both “Minority” and
“Below Poverty” block group boxes are checked, you will be able to obtain data for both.



10.

11.

Once you have both data layers on, select the “Identify” button on the left side of the screen. This
will open another box where you can either select “Drag a Rectangle on the map” or “Define an area
(right mouse-click to end)” icon.

This will allow you to draw a box around your project area. Once you have dragged a rectangle on the
map or have drawn an area and right clicked to end the drawing, a “Results” box will pop up. Please
note that it may take a few seconds for this box to open. Once it opens, you should see the word
“Demographics” in this result box. Click on this word (not the + next to the word) and the minority
and below poverty block group data for your project area should appear. The results box should
display minority and below poverty percentages for each block group within your project area.
Please note that you may have several block groups for your particular project area. This data search
will include all block groups within the project area.

These are the data you will need to include in the table on the Environmental Justice tab in the on-
line CE form. The data from the “Results” box can be copied and pasted into the form. Because the
table in the on-line CE form requires you to enter in each block group and its associated data
separately, you will need to copy and paste each line of block group data separately from the “Results”
box in EJ View. You can copy each line (block group ID and its associated percentage) from the
“Results” box in EJ View and paste it into a block group ID line in the table on the on-line CE form. You
will then need to copy and paste each percentage into the table, under the appropriate heading
(minority or low income). Please continue this step until you have copied and pasted all of the block
group data from the “Results” box of EJ View into the on-line CE form. Because the “Results” box
separates the below poverty and minority percentages into two tables, please note that you will need
to make sure when copying and pasting into the on-line CE table that each percentage is correctly
copied and pasted with the associated block group ID. Remember that the “Below Poverty” data (EJ
View) and “Low Income” data (on-line CE form) are the same. Please note for the 2010 “Minority
Data” you will need the “GeolD10” column and “Percent Minority” column. It does not appear that
this data can be easily copied and pasted so you may need to manually enter this data for each block
group in the report.

If you close the “Results” box but need to re-open it to view the data again, you can simply click on
the shape that you drew and the “Results” box should reappear. However, if you have deleted the
shape that you drew, you will need to draw the shape again in order for the “Results” box to reappear
and obtain the data.

If you need to delete a shape and draw a new one, close the “Results” box and simply click on one of
the three ways to identify a project area in the “Identify” box. This will delete your current shape and
allow you to draw a new one. You can also delete shapes by closing the “Identify” box and reopening
it. Please note that shapes drawn using the “Identify” button will not delete by selecting the “Erase”
tab.

Lastly, you will need to print a map showing each data set. Please note you can only have one layer of
data selected at a time (either the “Minority” or “Below Poverty”) and you must print each one
separately. Please also ensure the “Results” box is closed prior to printing.

First begin printing the Below Poverty demographics. To do this, please select “Print Screen” from
your keyboard. Select the “Copy” icon from top of the page. Open Microsoft Word and paste this
image into the Word document. You will then need to draw a box around your project area. First,
select the “Insert” tab from the top of the Word document. From this tab, select Shapes, Lines, and
select the second icon from the right labeled “freeform”. This will allow you to draw a shape around
your project or study area. Once you have drawn your shape, you will need to use your mouse to click
on your shape and then select the “Format” tab. Select the “Shape Fill” and then select “No Fill”. You
can also change the color of the shape if you choose.

Follow these same steps to turn on the “Minority” data layer as well in the “Demographics (SF1) 2010”
folder and to create a map.



Identifying Impacts to Environmental Justice Populations
Once you have identified any potential Environmental Justice populations within your proposed project

or study area, you will need to determine what impacts will occur as a result of the proposed project and
whether these populations will be impacted. You will also need to include these populations in the Public
Involvement process. The questions provided in the Environmental Justice tab of the CE Online form are
meant to aid in the assessment of whether your proposed project will have a disproportionately high and
adverse effect on an Environmental Justice population.

Avoidance, Minimization and/or Mitigation may be necessary if it is determined impacts will occur to
these populations. If you think your project may have an impact on an Environmental Justice population,
you should coordinate with OES as early as possible. Please contact OES if an Environmental Justice
Analysis Report is required for your project or if you have any questions.

Guidance for How to Address Environmental Justice in Reevaluations on Paper Forms

For those projects that require a reevaluation using the paper CE form or a narrative version, please state
in the remarks box/Environmental Justice section whether the populations present within your proposed
project area are 40% or greater or less than 40%. If the minority and/or low-income data indicate a
population of 40% or greater within your proposed project area, you will also need to answer the above
questions in a narrative format in the remarks box of the paper CE form or in the Environmental Justice
section if you are preparing a narrative reevaluation.

Finally, please be sure to include the two maps from EJ View in the appropriate Appendix of the
reevaluation and use the appropriate standard language (provided above) in the remarks
box/Environmental Justice section. Please note that you are no longer required to compare the project
area data to that of the Municipality, County and/or State data. If your proposed project area contains a
population of 40% or greater and you answered “Yes” to any of the above questions, an EJ Analysis Report
will be required. Please follow the above guidance to complete this report.



